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About this document

The product IBM® WebSphere Business Integration Server Express Plus is made
up of the following components: InterChange Server Express, the associated
Toolset Express, CollaborationFoundation, and a set of software integration
adapters. The tools in Toolset Express help you to create, modify, and manage
business processes. You can choose from among the prepackaged adapters for your
business processes that span applications. The standard processes
template--CollaborationFoundation--allows you to quickly create customized
processes.

This document describes configuration, business object development, and
troubleshooting for the IBM WebSphere Business Integration Server Express Plus
Adapter for ]D Edwards One World.

Audience

This document is for consultants, developers, and system administrators who
support and manage the WebSphere Business Integration Server Express Plus
system at customer sites.

Prerequisites for this document

Users of this document should be familiar with the WebSphere business integration
system, with business object and collaboration development, and with the JD
Edwards OneWorld technology.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
Express Plus installations, and includes reference material on specific components.

You can download, install, and view the documentation at the following site:
http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter

Note: Important information about this product may be available in Technical
Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Server Express
Plus Support Web site,
|http: / /www.ibm.com/software/integration/websphere/support/ l

Select the component area of interest and browse the Technotes and Flashes
sections.

Typographic conventions

This document uses the following conventions:

courier font Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.
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bold
italic, italic
blue text

{1}
[]

/i \

%text% and $text

ProductDir

Indicates a new term the first time that it appears.

Indicates a cross-reference or variable name.

Blue text, which is visible only when you view the manual
online, indicates a cross-reference hyperlink. Click any blue
text to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.1og.

In this document, backslashes (\) are used as the convention
for directory paths for Windows. OS/400 uses forward
slashes (/) for directory paths. All WebSphere Business
Integration Server Express system product pathnames are
relative to the directory where the product is installed on
your system.

Text within percent (%) signs indicates the value of the
Windows text system variable or user variable.

Represents the directory where the IBM WebSphere Business
Integration Server Express for Adapters product is installed.
The defaults for each platform are as follows:

Windows: IBM\WebSphereServer

0OS5/400: /QIBM/ProdData/WBIServer43/product

For OS/400, the capacity pack adapters are in
/QIBM/ProdData/WBIServer43/AdapterCapacityPack.

Adapter for JD Edwards OneWorld User Guide



New in this release

New in Release 4.3.1

This release adds support for the following operating systems:
* Windows 2000

* Windows 2003

« IBM OS/400 V5R2, V5R3

New in Release 4.3

This is the first release of this guide.

© Copyright IBM Corp. 2004
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Chapter 1. Overview

This chapter is an overview of the connector component of the WebSphere
Business Integration Server Express Plus Adapter for JD Edwards OneWorld and
contains the following sections:

”Terminoloéz”l

“Adapter overview” on page 2|

“Connector architecture” on page 2|

“How the connector works” on page 5|

“Processing locale-dependent data” on page 7|

Terminology

The following terms are used in this guide:

© Copyright IBM Corp. 2004

ASI (Application-Specific Information) Metadata tailored to a particular
application or technology. ASI exists at both the attribute, verb, and business
object level of a business object. See also Verb ASI.

BF (Business Function) A collection of C functions and their associated data
structures, logically grouped to perform a specific task. Regular business
functions perform simple tasks, such as tax calculation or account number
validation. Master business functions perform tasks that are more complex and
can call several regular business functions.

BO (Business Object) A set of attributes that represent a business entity (such as
Employee) and an action on the data (such as a create or update operation).
Components of the WebSphere business integration system use business objects
to exchange information and trigger actions.

BO (Business Object) handler A connector component that contains methods
that interact with an application and that transforms request business objects
into application operations.

Connector agentA component of the connector that processes service call
requests from InterChange Server Express as well as event notifications from
OneWorld.

Connection object A connection is a reference to an application that can contain
state information. For every instance of a connection on the adapter side, there is
a corresponding object on the JD Edwards OneWorld side. The BO handler
creates connections when required, up to the maximum size of the value of the
pool size property. The new connections are maintained in the pool and are
re-used by multiple business object executions.

Connection pool A repository used to store and retrieve connection objects.

GenJava A utility provided by JD Edwards OneWorld to generate Java wrappers
for the business functions running as part of the OneWorld server. GenJava
creates Java Class files for the interface classes and associated data structures,
compiles the generated Java files, generates Java docs, and packages them into
two jar files: one for Java classes and the other for Java doc.

Interoperability framework Allows seamless sharing of function and
information between disparate software applications. Includes business function
wrappers that provide a single point of access to major and minor business
functions. Also includes master business function wrappers.



* Java objects Wrappers, implemented in Java, around OneWorld business
functions and data structures. Java objects provide a one-to-one correspondence
with OneWorld business functions.

* ODA (Object Discovery Agent) A tool that automatically generates a business
object definition by examining specified entities within the application and
“discovering” the elements of these entities that correspond to business object
attributes. When you install the adapter, the ODA is automatically installed.

* Verb ASI (application-specific information) For a given verb, the verb ASI
specifies how the connector should process the business object when that verb is
active. It can contain the name of the method to call to process the current
request business object.

Adapter overview

The adapter for JD Edwards OneWorld is a runtime component of the WebSphere
Business Integration Server Express Plus Adapter for JD Edwards OneWorld. The
JD Edwards OneWorld Adapter includes a connector, message files, configuration
tools, and an Object Discovery Agent (ODA). The connector allows the integration
broker, InterChange Server Express, to exchange data between business objects and
their corresponding OneWorld objects running on a OneWorld server.

The primary role of the generic OneWorld adapter is to act as an agent to facilitate
communication and data exchange between a OneWorld server and InterChange
Server Express. The adapter is developed in Java and uses the OneWorld
component jar files generated by the GenJava interface tool, provided by
OneWorld.

OneWorld objects are business functions that run as part of the OneWorld server.
The WebSphere Business Integration Server Express Plus Adapter for OneWorld
uses the OneWorld Java connector to invoke business functions.

Connector architecture

Connectors consist of two components: the connector framework and the
application-specific component. The connector framework, whose code is common
to all connectors, acts as an intermediary between InterChange Server Express and
the application-specific component. The application-specific component contains
code tailored to a particular technology (in this case, JD Edwards OneWorld) or
application. The connector framework provides the following services between
InterChange Server Express and the application-specific component:

* Receives and sends business objects
* Manages the exchange of startup and administrative messages

This document contains information about both the connector framework and the
application-specific component. It refers to both of these components as the
connector.

All WebSphere Business Integration Server Express Plus adapters operate with

InterChange Server Express, the intergration broker. For more information, see the
installation and implementation documentation of your broker.
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Figure 1. Business object architecture

Business functions

OneWorld business functions perform specific tasks, such as journal entry
transactions, calculating deprecation, and sales order transactions. There are two
types of business functions. Regular business functions perform simple tasks, such
as tax calculation or account number validation. Master business functions perform
tasks that are more complex, and can call several regular business functions to
perform those tasks.

The interoperability framework includes business function wrappers that provide a
single point of access to major and minor business functions. It also includes
master business function wrappers. The following figure illustrates how OneWorld
and third party applications interact using APIs and master business functions.

OneWorld supports several APIs for communication with third-party applications
such as Java, COM, native proprietary database APIs for DB2 and Oracle, XML,
and Table Conversion.

The adapter uses the Java APIs for invoking business functions in OneWorld. The
business objects map to business function classes or objects.

A summary of the implementation is as follows:

1. Prepare an iJDEScript file for running the GenJava process. Refer to
[GenJava script file” on page 38

Chapter 1. Overview 3



2. Run the GenJava utility to generate the jar files for OneWorld objects.
3. Set the key fields.
4. Add the business objects to the adapter configuration file. Refer to

[“Connector Configurator Express,” on page 61)

5. Start the adapter. Refer to [‘Starting the connector” on page 16

Request processing

When the connector framework receives a request from InterChange Server
Express, it calls the doVerbFor() method of the business-object-handler class
associated with the business object definition of the request business object. The
role of the doVerbFor() method is to determine the verb processing to perform,
based on the active verb of the request business object. It obtains information from
the request business object to build and send requests for operations to the
application.

When the connector framework passes the request business object to doVerbFor(),
if the business object maps to an interface object, the BO handler reads the verb
ASI and translates it into a series of callable functions. You can give these functions
specific semantic meaning through the Object Discovery Agent (ODA) running in
Business Object Designer Express. For details about using the ODA to assign a
method call sequence to a verb, see [Chapter 4, “Creating and modifying business|
fobjects,” on page 21] The order in which the calls are made is critical to the
successful processing of the object.

In the case of an interface business object with a blank verb ASI, the BO handler
searches for a business function attribute with populated parameters and calls that
business function. Only one method can be populated; otherwise, if multiple
methods are populated but the verb ASI is blank, the connector logs an error and
returns a FAIL code. For details about error processing, see|“Error handling” on|

If the business object maps to a business function object, the BO handler invokes
the specific business function with the data specified in the business object.

The connector does not support any specific verbs for the interface business
objects, but using the ODA, the user can configure verbs for a business object. The
standard verbs used by WebSphere Business Integration Server Express Plus are
Create, Retrieve, Update, and Delete.

For business function business objects, the ODA generates a default verb, Execute.
The verb ASI is not required for these business objects.

To support special access permissions for a business object, a meta business object
is defined with the name ACCESS_LEVEL. The ACCESS_LEVEL business object has two
attributes, Username and Password, both of type String. A OneWorld business object
that has special access rules and cannot be accessed through the Username specified
in the connector configuration file, would have this business object (ACCESS_LEVEL)
as a child business object with single cardinality. You must add this child business
object only to the top-level business object in a doVerbFor call. All the child
business objects for this top-level business object must be accessible through the
Username specified in the ACCESS_LEVEL child business object.

The BO handler checks to see if the top-level business object has a child business
object of type ACCESS_LEVEL. If yes, and the value for the Username attribute in that
business object is different from what is being used by the adapter, then it opens a

4  Adapter for JD Edwards OneWorld User Guide



new connection for processing this business object using the value for attributes
Username and Password of the child business object. The connection closes after the
processing of the business object is complete.

If the top-level business object does not have a child business object of type
ACCESS_LEVEL, or the value of the Username attribute is the same as the Username
specified in the adapter properties, the BO handler fetches a connection object from
the pool.

If there is no available connection object and the maximum limit of the pool size is
not reached, the BO handler creates a new connection object in the pool. If there is
no available connection object and the maximum limit of the pool size is reached,
then it waits for a connection object become available.

Processing application events

Event notification requires the installation of the event package, BIA_EVENT, shipped
with the adapter and the creation of event and archive tables in the JDE database.

For information about how to install and configure the BIA EVENT event package,
refer to [“Installing and configuring IBM event store” on page 19)

The creation, update, or deletion of any record in the JD Edwards OneWorld
application can be treated as an event. You can use table triggers, supported by
OneWorld, to populate the event table. You can also use any other JD Edwards
recommended method to generate events into the event table. During a call to
pollForEvents, these records are obtained and processed. The Event table stores
information about the event, as described in [Table 6 on page 36

Note: The Event ID must be unique in the Event table.

Note: The connector uses the information in during event subscription to
build corresponding business objects and to send those objects to the
connector framework for further processing.

Retrieving business objects for event processing

Retrieval of objects for event processing is based on both key and non-key
attributes. It is mandatory that the business object support the Execute verb if the
business object represents a JD Edwards business function and that is supports the
Retrieve verb if the business objects represents an interface.

Event management

The connector polls the IBM Event table (F5501005) at a regular interval, retrieves
the events, and processes the events first by priority and then sequentially. When
the connector has processed an event, the event’s status is updated appropriately.

The setting of the ArchiveProcessed property determines whether the connector
archives an event into the IBM Archive table (F5501006) after updating its status.
For more information on the ArchiveProcessed property, see|“Configuring the]
lconnector” on page 13.[[Table 2 on page 14|illustrates the archiving behavior
depending on the setting of the ArchiveProcessed property.

How the connector works

This section describes how the different parts of the connector process a business
object:

Chapter 1. Overview 5



1. Upon startup of the connector, the connector’s Agent class performs the
following initialization (Init) processes:

Retrieves configuration properties.

Fetches the Username and Password, and Environment from the connector
configuration file.

Creates a OneWorld connector object.

Logs in to the OneWorld server using the Login method and parameters
using the Username and Password as fetched above. This method returns a
SessionID.

Creates an instance of the OneWorld interface object.

Adds the connector, OneWorldInterface, and SessionID to the connection
pool.

2. The OneWorld BO handler reads the verb ASI and translates it into a sequence
of callable functions or child objects.

If the business object has a child business object of type ACCESS_LEVEL and
the Username attribute within this child business object is populated and has
a value that is different from what is used by the adapter, then the BO
handler opens a new connection using the values of the Username and
Password attributes specified for the ACCESS_LEVEL business object. All such
business objects must have both Username and Password attributes populated.

If the connection creation fails because the application is down, the BO
handler returns APPRESPONSETIMEOUT.

If the connection creation fails because the Username/Password is wrong, then
the BO handler logs an error and returns a FAIL status.

If the business object does not have a child business object of type
ACCESS_LEVEL, or the value for the Username attribute in this business object is
null or has the same value as specified for the adapter Username, then it
fetches a connection form the available connection pool. The following steps
represent what would happen in the connection pool when the BO handler
requests an available connection:

a. The BO handler checks to see if there are available connections in the
pool.

b. If yes, it checks for the validity of the connection. If it is not valid it
attempts to recreate the connection.

c. If the connection creation fails, it returns APPRESPONSETIMEQUT status.

d. The BO handler removes the connection from the available list and adds
it to the busy list.

e. If the connection is not available and the maximum number of
connections is less than the pool size, then it opens a new connection and
adds it to the connection pool’s busy list. If opening a new connection
returns a failure, the adapter returns APPRESPONSETIMEOUT.

f. If no connections are available and the maximum limit of the pool size

has been reached, then the doVerbFor thread waits until a connection
becomes available.

If the business object is of type BFN, then the adapter performs the following
actions:

a. The adapter starts a transaction using the BeginTransaction method of
the OneWorld class OnelorldInterface.

b. If the business object maps to an interface class and if the verb ASI is
blank, the adapter finds the first method attribute or the first child object
that is populated in the business object and executes. it.
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c. If the verb ASI is populated, the adapter calls InvokeMethods, which loops
through all the methods specified in the verb ASL

d. If the business object maps to a business function, Invoker executes the
business function that maps to the business object. If there are child
business objects that are not of type ACCESS_LEVEL, the BO handler loops
through them and executes the business functions corresponding to them
in the order in which they are defined in the top-level business object.

e. Invoker constructs the arguments based on the attributes defined in the
business object and then invokes the method on OneWorld Java objects
using reflection APIs.

f. If the execution of the complete business object succeeds, the BO handler
commits the transaction using the Commit method on object
OneWOrldInterface and returns a VALCHANGED status.

* Releases the connection to the connection pool.
* Returns VALCHANGED upon successful execution of the business functions.

¢ Returns FAIL if the business object is of type BFN and maps to the Interface
class and the verb ASI is blank and no attributes are populated.

* Returns FAIL when processing fails.

3. The ConnectionEventStore class performs the following for subscription
delivery:

* When the connector encounters an event, it
— creates a business object of the type specified by the event,

— sets the key and non-key values for the business object (using the object
key specified in the event table),

— sets the verb as Execute if the business object is of type business function,
— sets the verb as Retrieve if the business object is of type interface.

* After it retrieves the business object, the connector sends it to InterChange
Server Express with the verb specified in the event.

4. Terminates (Terminate) by closing all the connections from the connection pool.

Processing locale-dependent data

The adapter has been internationalized so that it can support double-byte character
sets, and deliver message text in the specified language. When the adapter
transfers data from a location that uses one character code set to a location that
uses a different code set, it performs character conversion to preserve the meaning
of the data.

The Java runtime environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encodings for characters
in most known character code sets (both single-byte and multibyte). Most
components in the WebSphere Business Integration Server Express system are
written in Java. Therefore, when data is transferred between most WebSphere
Business Integration Server Express system components, there is no need for
character conversion.

To log error and informational messages in the appropriate language and for the
appropriate country or territory, configure the Locale standard configuration
property for your environment. For more information on configuration properties,
see|Appendix A, “Standard configuration properties for connectors,” on page 47

Chapter 1. Overview 7
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Chapter 2. Installing the adapter

“Compatibility”]

+ [“Assumptions and third-party dependencies’]
+ |“Installing the adapter for JD Edwards OneWorld and related files”|
* |“Adapter file structure” on page 10

* |“Post-installation tasks” on page 11

Compatibility

The adapter framework that an adapter uses must be compatible with the version
of InterChange Server Express, the integration broker, with which the adapter is
communicating. This version of the adapter for OneWorld is supported on the
following adapter framework and integration brokers:
* Adapter framework:
— WebSphere Business Integration Server Express Plus Adapter Framework
V4.3.1

* Integration brokers: InterChange Server Express

Assumptions and third-party dependencies

Review the following assumptions and software requirements before you install
the adapter for JD Edwards OneWorld.

Platform requirements

The adapter is supported on the following platforms:
* Windows 2000

* Windows 2003

+ IBM OS/400 V5R2, V5R3

In addition, the adapter can be installed on the supported platforms and
configured as a distributed adapter to communicate with InterChange Server
Express installed on any of the following platforms:

* Windows 2000

* Windows 2003

» IBM OS5/400 V5R2, V5R3

* Red Hat Enterprise Linux 3.0 Update 1

¢ SuSE Linux Enterprise Server 8.1 with SP3

For information about configuring distributed adapters, see "Distributed adapter
environments” in the System Implementation Guide.

Installing the adapter for JD Edwards OneWorld and related files

© Copyright IBM Corp. 2004

For information on installing the adapter, see the discussion of installing from the
Adapter Capacity Pack for WebSphere Business Integration Server Express Plus, in
the Installation Guide for WebSphere Business Integration Server Express, located in the
WebSphere Business Integration Server Express Infocenter at the following site:



http:/ /www.ibm.com/websphere /wbiserverexpress/infocenter

WebSphere Business Integration Server Express Plus Adapter

directories and

files

After the installation is complete, you can view the file system and its contents.
The folders and files created vary depending on the choices made during the
installation and on the operating system.

The Installer copies the standard files associated with the connector into your
system. For Windows, it installs the connector agent into the
ProductDir\connectors\OneWorld directory, and adds a shortcut for the connector
agent to the Start menu. For OS/400, a shortcut is added automatically to the
WebSphere Business Integration Console.

Adapter file structure

The Installer copies the standard files associated with the adapter, also called the
connector, into your system.

The utility installs the connector into the ProductDir\connectors\OneWorld
directory, and adds a shortcut for the connector to the Start menu. Note that
ProductDir represents the directory where the product is installed.

describes the file structure used by the connector, and shows the files that

Table 1. File structure for

are automatically installed when you choose to install the connector through the
Installer.

the connector

Subdirectory of ProductDir
\connectors\OneWor1d\BIA_OneWorld.
\connectors\OneWorld\start_OneWorl
\connectors\OneWorld\start_OneWorl
\connectors\OneWor1d\dependencies\
\connectors\OneWorld\dependencies\!
\connectors\OneWor1d\dependencies\
\connectors\messages\BIA_OneWor1dA
\ODA\OneWor1d\BIA_OneWor1dODA. jar
\ODA\OneWorld\start_OneWor1dODA.ba
\ODA\OneWorld\start_OneWor1dODA.sh
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
\ODA\messages\BIA_OneWor1dODAAgent
%CROSSWORLDS%\bin\data\app\Bia_One

Description
Jar Contains classes used by the OneWorld connector only
d.bat The startup script for the generic connector (Windows)
d.bat The startup script for the generic connector (OS/400)
IBMEventsInterop.jar Contains IBM eventstore classes
BIA_EVENT.exe Executable that installs the eventstore package
Jjdeinterop.ini Contains the enterprise server
dapter.txt Message file for the connector

The OneWorld ODA
t The ODA startup file (Windows)

The ODA startup file (OS/400)

_de_DE.txt Message file for the ODA (German text strings)
_en_US.txt Message file for the ODA (US English text strings)
_es_ES.txt Message file for the ODA (Spanish text strings)
_fr_FR.txt Message file for the ODA (French text strings)

_it_IT.txt Message file for the ODA (Italian text strings)

_Ja_JP.txt Message file for the ODA (Japanese text strings)
_ko_KR.txt Message file for the ODA (Korean text strings)

_pt_BR.txt Message file for the ODA (Portuguese - Brazil text strings)
_zh_CN.txt Message file for the ODA (Simplified Chinese text strings)
_zh_TW.txt Message file for the ODA (Traditional Chinese text strings)
WorldConnectorTemplate Repository definition for connector. Generate config file with this template. (Windows only)

Note: All product pathnames are relative to the directory where the product is
installed on your system.
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Post-installation tasks

After you have successfully installed the Adapter for JD Edwards OneWorld,
complete the following post-installation tasks:

* |“Configure the adapter”|

* |“Copy files”

* [“Create an ODBC connection”]

Configure the adapter

After you install the adapter and before you start it for the first time, you must
configure the adapter. For details, see [Chapter 3, “Configuring the connector,” onl

Copy files

During installation GenJava generates .jar files containing business function classes
used by the adapter. Copy these jar files into the
ProductDir\connectors\OnelWorld\repository folder. The adapter and ODA
dynamically upload these files.

In addition, do the following:

For Windows, copy the Kernel.jar and Connector. jar files, located in the
B7334\System\classes folder, to the
ProductDir\connectors\OneWorld\dependencies folder.

For OS/400, copy the files to

/QIBM/UserData/WBIServerd3/instance _name/connectors/OneWorld/dependencies,
where instance_name is the name of the InterChange Server Express instance.

Create an ODBC connection

The OneWorld adapter requires an ODBC data source for each DB2 UDB database
in order to start and poll the connector. For information about how to create an
ODBC connection, refer to the JD Edwards Installation Guide.

Chapter 2. Installing the adapter 11
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Chapter 3. Configuring the connector

After installation and before startup, you must configure components as described
in this section.

+ [“Configuring the connector”|

+ |“Creating multiple connector instances” on page 15

* |“Starting the connector” on page 16

+ [“Stopping the connector” on page 18|

» |"Using log and trace files” on page 20|

Configuring the connector

Adapters have two types of configuration properties: standard and
adapter-specific. You must set the values of these properties using Connector
Configurator Express before running the adapter. For further information, see
[Appendix B, “Connector Configurator Express,” on page 61.

A connector obtains its configuration values at startup. During a runtime session,
you might want to change the values of one or more connector properties.
Changes to some connector configuration properties take effect immediately.
Changes to other connector properties require connector component restart or
system restart after a change. To determine whether a property is dynamic (taking
effect immediately) or static (requiring either connector component restart or
system restart), refer to the Update Method column in the Connector Properties
window of System Manager.

0S/400
For OS/400, the JDEInterop.ini file must be edited with OS/400-specific
values in order for the connector to work.

Standard connector properties

Standard connector configuration properties provide information that all adapters
use. See|Appendix A, “Standard configuration properties for connectors,” on page|
for documentation of these properties.

Connector-specific properties

Connector-specific configuration properties provide information needed by the
adapter at runtime. These properties also provide a way for you to change static
information or logic within the connector without having to recode and rebuild it.

To configure connector-specific properties, use Connector Configurator Express.
Click the Application Config Properties tab to add or modify configuration
properties. For more information, see|Appendix B, “Connector Configurator|
[Express,” on page 61)

[Table 2 on page 14]lists the connector-specific configuration properties for the
connector, along with their descriptions and possible values. See the sections that
follow for details about the properties.
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Table 2. Connector-specific configuration properties

Name Possible values Default value

[Coemand IDE Nore

o D None

[PoolSizd 5 1

[Environment DV7334 None

[Connectorid None. None.

I|EventStoreFactory| com.ibm.adapters.oneworld. com.ibm.adapters.
OnelWorTdEventStoreFactory oneworld.
Instance OneWorldEventStore

FactoryInstance

[mDoubtEvents| Reprocess Reprocess

|ArchiveProcessed| True, False True

Username

The Username for connecting with the OneWorld application. This is a required

property.

Password

The Password for connecting with the OneWorld application. This is a required

property.

PoolSize

The maximum number of connections in the Connection Pool. This should not be
more than the maximum allowed connections specified in the JDEInterop.ini file.
This is a required property.

Note: For OS/400, the JDEInterop.ini file must be edited with OS/400-specific
values.

Environment
Name of the environment in which the connection has to be done within
OneWorld. This is a required property.

Connectorld
This configuration property is not supported in this release.

EventStoreFactory
This property is the name of the event store factory instance class. The value is
com.ibm.adapters.omeworld.OneWorTdEventStoreFactoryInstance.

InDoubtEvents
Decides whether or not to reprocess incomplete events. Default value is Reprocess
and must not be changed.

ArchiveProcessed

Checks if the default value is set or not. If ArchiveProcessed is set to true, the
archival business function archives the event into the archive table. If the property
is set to false or is not set, the archival business function is not called.
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Creating multiple connector instances

Note: When you create an additional instance of this adapter (or any adapter that

is supplied with WebSphere Business Integration Server Express or Express
Plus), that instance of the adapter is counted as a separate adapter by the
licensing function that limits the total number of adapters that can be
deployed.

You can set your system up to create and run multiple instances of a connector by
following the steps below. You must:

Create a new directory for the connector instance
Make sure you have the requisite business object definitions
Create a new connector definition file

Create a new start-up script

Creating a new directory

You must create a connector directory for each connector instance. Name the
connector directory as follows:

For Windows platforms,
ProductDir\connectors\connectorInstance

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file,
create this directory and store the file here:

ProductDir\repository\connectorInstance

You can specify the server name as a parameter of startup.bat; an example is
start_OneWorld.bat connName serverName.

For OS/400 platforms,
/QIBM/UserData/WBIServer43/WebSphereICSName/connectors/ connectorInstance

where connectorlnstance uniquely identifies the connector instance and where
WebSphereICSName is the name of the InterChange Server Express instance with
which the connector runs

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file,
create this directory and store the file here:
/QIBM/UserData/WBIServerd3/WebSphereICSName/repository/ connectorInstance

where connectorlnstance uniquely identifies the connector instance and where
WebSphereICSName is the name of the InterChange Server Express instance with
which the connector runs

Creating business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them:

1.

If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Rename them if you make changes to them.

2. Files for the initial connector should reside in the appropriate directory:

* Windows:
\ProductDir\repository\initialConnectorInstance
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Any additional files you create should be in the appropriate connector
instance subdirectory of \ProductDir\repository

+ 0S/400:
QIBM/UserData/WBIServerd3/WebSphereICSName/repository/
initialConnectorlInstance
where WebSphereICSName is the name of the InterChange Server Express
server instance with which the connector runs.
Any additional files you create should be in the appropriate
connectorInstance subdirectory of:
/QIBM/UserData/WBIServer43/WebSphereICSName/repository

Creating a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Creating a start-up script
To create a startup script, do the following:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. Put this startup script in the connector directory you created in
[new directory” on page 15.|

3. (For Windows only.) Create a startup script shortcut.

4. (For Windows only.) Copy the initial connector’s shortcut text and change the
name of the initial connector (in the command line) to match the name of the
new connector instance.

5. (For OS/400 only.) Create a job description for the connector using the
information below: CRTDUPOB] OBJ(QWBIJDEC) FROMLIB(QWBISVR43)
OBJTYPE(*JOBD) TOLIB(QWBISVR43) NEWOBJ(newOneWorldname)

where neweOneWorldname is a 10-character name that you use for the job
description for your new OneWorld connector

6. (For OS/400 only.) Add the new connector to the WebSphere Business
Integration Console. For information about the Console, refer to the online help
provided with the Console.

You can now run both instances of the connector on your integration server at the
same time.

Starting the connector

A connector must be explicitly started using its connector start-up script. The
startup script should reside in the connector’s runtime directory. For example, for
Windows use:

ProductDir\connectors\connName

where connName identifies the connector. The name of the startup script depends
on the operating-system platform, as [Table 3 on page 17| shows.
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Table 3. Startup scripts for a connector

Operating system Startup script
Windows start_connName .bat
0S/400 start_connName.sh

For more information on how to start a connector, including the command line
start-up options, refer to the System Administration Guide.

Invoking the start-up script on Windows

On Windows platforms, you can invoke the connector start-up script in the
following ways:

* From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

¢ From the Start menu

— Select Programs > IBM WebSphere Business Integration Express > Adapters >
Connectors > your_connector_name
By default, the program name is IBM WebSphere Business Integration
Express. However, it can be customized. Alternatively, you can create a
desktop shortcut to your connector.

— On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for
an Auto service) or when you start the service through the Windows Services
window (for a Manual service).

* From the command line
start_connName connName WebSphereICSName [-cconfigFile ]

where connName is th name of the connector and WebSphereICSName is the name
of the InterChange Server Express instance. By default, the name of the
InterChange Server Express isntance is WebSpherelCS.

Invoking the start-up script on 0S/400

On OS/400 platforms, you can invoke the connector start-up script in the
following ways:

* From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

e From Windows

Where the WebSphere Business Integration Console is installed, select Programs
> IBM WebSphere Business Integration Console > Console. Then, specifiy the
0S/400 system name or IP address and a user profile and password that has
*JOBCTL special authority.Select the connName adapter from the list of adapters
and select the Start Adapter button.

¢ From the OS/400 command line
In Batch mode: Run CL. Command QSH and from the QSHELL environment
run /QIBM/ProdData/WBIServer43/bin/submit_adapter.sh connName
WebSphereICSName pathToConnNameStartScript jobDescriptionName
where connName is the connector name, WebSphereICSName is the InterChange
Server Express server name (default is QWBIDFT), pathToConnNameStartScript is
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the full path to the connector start script, jobDescriptionName is the name of the
job description to use in the QWBISVR43 library (default job description is
QWBIJDEC).

In interactive mode: Run the CL command QSH and from the QSHELL
environment, run /QIBM/UserData/WBIServer43/WebSphereICSName/connectors
/connName/start_connName.sh connName WebSphereICSName [-cConfigFile]
where connName is the name of your connector and WebSphereICSName is the
name of the Interchange Server Express instance.

Note: To start with TCP/IP servers, use this command:
/QIBM/ProdData/WBIServer43/bin/add_autostart_adapter.sh connName
WebSphereICSName pathToConnNameStartScript jobDescriptionName, where
connName is the connector name, WebSphereICSName is the InterChange
Server Express server name (default is QWBIDFT),
pathToConnNameStartScript is the full path to the connector start script,
jobDescriptionName is the name of the job description to use in the
QWBISVR43 library (default job description is QWBIJDEC).

Stopping the connector

The way to stop a connector depends on the way that the connector was started.

Stopping the connector from Windows
On Windows platforms, you can stop the connector in the following ways:
* From System Monitor

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* Activate the connector window, type "q" and then press Enter.

* If the connector started as a Windows service, you can stop it through Control
Panel.

Stopping the connector from 0S/400
On OS/400 platforms, you can stop the connector in the following ways:
* From System Monitor

You can load, activate, deactivate, pause, shutdown, or delete a connector using
this tool.

e From the WebSphere Business Integration Console or command line

If you started the connector using the Console or using the submit_adapter.sh
script in QSHELL, from the OS/400 command entry, use the CL Command
WRKACTJOB SBS(QWBISVR43) to display the jobs to the Server Express
product. Scroll the list to find the job with a jobname that matches the job
description for the connector (for JD Edwards, the jobname defaults to
QWBIJDEC).

Select option 4 on this job, and press F4 to get the prompt for the ENDJOB
command. Then specify *IMMED for the Option parameter and press enter.

 If you used the start_connName.sh script to start the adapter from QSHELL,
press F3 to end the connector.
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Installing and configuring IBM event store

The adapter package includes an executable BIA_EVENT.exe file. This executable file
installs the IBM event store components. ]D Edwards refers to this as a software
update. Follow the JD Edwards instructions for applying a software update. Event
store (software update) components comprise an event and archive table and
business functions used for retrieving, deleting, updating, and archiving events in
the event and archive table.

Business functions for event handling, table definition files, and data items are part
of the event package BIA_EVENT.exe. You must prepare the deployment server or
workstation before executing a software update, then follow the software update
procedure. The JD Edwards Software Update Installation Guide describes the
preparation and update procedures in detail.

The BIA_EVENT.exe file creates the required business functions and table definition
scripts, however you must create the event and archive tables using the JD
Edwards client. Once you have successfully installed the software update on the
deployment server or workstation you must deploy the components to the
enterprise server so the adapter can find the event store.

The contents of the BIA_EVENT package are as follows:
* B551005 — Retrieve WBIAEvents

* B551006 — Update_WBIAEvent

e B551007 — Archive_WBIAEvent

* B551008 — Delete_WBIAEvent

* B551009 — Recover_WBIAEvent

The following are the Tables Definitions files:
e F5501005.h — Event table structure
e F5501006.h — Archive table structure

The following data items are included:
e EVENT_ID
« EVT_DESC
e EVT_PRTY
* EVT_STATUS
e EVT_TIME
* ADAPTER_ID
e ARCHIVE_T
« 0BJ_KEY

* OBJ_NAME
+ 0BJ_VERB

Note: Other data items exist in the package but are not used by the tables and will
be removed from the package in the next release.
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Using log and trace files

The adapter components provide several levels of message logging and tracing.
The connector uses the adapter framework to log error, informational, and trace
messages. Error and informational messages are recorded in the log file, and trace
messages and their corresponding trace levels (0 to 5) are recorded in a trace file.
For details about logging and trace levels, see [Chapter 6, “Error handling,” on page|

You configure both the log and trace file names, as well as the trace level, in

Connector Configurator Express. For details about this tool, see

[“Connector Configurator Express,” on page 61

Error messages for ODA are logged into the trace file name specified for the ODA.
If an incorrect trace file name is specified, then the messages are sent to the screen
prompt where the ODA is running. Trace files and the trace level are configured in
Business Object Designer Express. The process is described in
lagent” on page 23] The ODA trace levels are the same as the connector trace levels,
defined in [“Tracing” on page 44.|
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Chapter 4. Creating and modifying business objects

This chapter describes the Object Discovery Agent (ODA) for JD Edwards
OneWorld, and how to use it to generate business object definitions for the IBM

WebSphere Business Integration Server Express Plus Adapter for JD Edwards
OneWorld.

This chapter contains the following sections:
» |“Overview of the ODA for OneWorld”|

* [“Generating business object definitions”]

» |"Uploading business object files” on page 31|

Overview of the ODA for OneWorld

An ODA (Object Discovery Agent) enables you to generate business object
definitions. A business object definition is a template for a business object. The
ODA examines specified application objects, “discovers” the elements of those
objects that correspond to business object attributes, and generates business object
definitions to represent the information. Business Object Designer Express provides
a graphical interface to access the Object Discovery Agent and to work with it
interactively.

The Object Discovery Agent (ODA) for JD Edwards OneWorld generates business
object definitions from the jar files generated by GenJava. The Business Object
Wizard automates the process of creating these definitions. You use the ODA to
create business objects and Connector Configurator Express to configure the
connector to support them. For information about Connector Configurator Express,
see|Appendix B, “Connector Configurator Express,” on page 61)

Generating business object definitions

This section describes how to use the JD Edwards OneWorld ODA in Business
Object Designer Express to generate business object definitions. For information on
launching and using Business Object Designer Express, see the Business Object
Development Guide.

Starting the ODA
Starting the ODA on Windows

The ODA can be run from any machine that can mount the file system on which
the metadata repository (that is, the IDL files) resides, using the
start_OneWorTdODA.bat for Windows 2000. This file contains start parameters,
including the paths to certain required OneWorld and connector .jar files.

The ODA for OneWorld has a default name of OneWor1dODA. The name can be
changed by changing the value of the AGENTNAME variable in the start script
(start_OneWorTdODA.bat).

To start the ODA, run this command:

start_OneWor1dODA
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Starting the ODA on 0S/400

Before the ODA can be started you must modify the ODA start script in:
/QIBM/UserData/WBIServerd3/<instance_name>/0DA/OneWorld/
start_OneWorTdODA.sh.

The line that sets the JAR_DIR directory must be changed to the location where
Kernel.jar and Connector.jar were copied.

Enter the path to the jar files that copied from JD Edwards Oneworld.

To start the ODA on OS/400, use one of the following methods:

* From the Windows system where WebSphere Business Integration Console is
installed, select Programs > IBM WebSphere Business Integration Console >
Console. Then specify the OS/400 system name or IP address and a user profile
and password that has *JOBCTL special authority. Select the ODA from the list
of ODAs and select the Start ODA button.

* From the OS/400 command entry run the QSH CL command and from the
QSHELL environment run /QIBM/ProdData/WBIServer43/bin/submit_oda.sh
script with the following parameters in order
pathToODAStartScript jobDescriptionName
Where pathToODAStartScript is the full path to the ODA start script and
jobDescriptionName is the name of the job description to use in the QWBISVR43
library.

* From the OS/400 Command entry, run the QSH CL Command and from the
QSHELL command entry, run the ODA startup script directly.
start_ODAName.sh

Running Business Object Designer Express

Business Object Designer Express provides a wizard that guides you through the
steps to generate a business object definition using the ODA. The steps are as
follows:

* |“Select the agent”]

+ |"Configure the agent” on page 23|

* |“Select a business object” on page 25|

* |"Confirm the object selection” on page 26|

Select the agent
1. Start Business Object Designer Express.

2. Click File > New Using ODA. The Business Object Wizard - Step 1 of 6 - Select
Agent screen appears.

3. Select the ODA/AGENTNAME (from the start_OneWor1dODA script) in the Located
agents list and click Next. (You may have to click Find Agents if the desired
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agent is not listed.)

Business Object Wizard - Step 1 of 6 - Select Y m]

Prezs "Find Agents” to locate ODAs Located agents:
it paur subnet (9026 237 2mm]. You
will be given an estimate of the time OneWorldODA [localhost:57037]

required to complete the operation
and a means to cancel the search.

[f you have an ODA that iz running
oh a machine outside subnet

9 26. 237w press "Caonfigure
Digoovery'' ta include that machine
iri the search.

Configure Dizcoveny |

| < | B

Agent's name: Onetw orld0 g,

Find Agents

Agent's host: Ilocalhost

Fuart; |5?|:|3?

< Back I Mest = I Cancel

Figure 2. Select Agent screen

Configure the agent

After you click Next, the Business Object Wizard - Step 2 of 6 - Configure Agent
screen appears. [Figure 3 on page 24| illustrates this screen with sample values.
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Business Dbject ¥ o [m] =S
— Profiles
Current profile; IEIneWu:urId j
Save | I e | Hemowve |
Property Yalue Type Description
1 BOPrefix =ting  |Prefix that will be uzed when
2 |JarFileDirectory | cicrozswworlds\connectarsio |String | The directory where the Jar fi
3 | TraceFileMame |(OneorldODAtrace i =ting  |Mame of the trace file.
4 | Tracelewvel 5 Integer | Trace level for the agent.
5 |MessageFie |BlA_OneWorldoDALgent td [String  |Mame of the error and messaq
J | i
¢ Back | Mext > | Cancel |

Figure 3. Configure Agent screen

The properties you set on this screen are described in You can save all the
values you enter on this screen to a profile. Instead of retyping the property data
next time you run the ODA, you simply select a profile from the drop-down menu
and re-use the saved values. You can save multiple profiles, each with a different
set of specified values.

Table 4. Configure Agent properties

Property name Default value | Type Description

BOPrefix None String The prefix that the ODA prepends to the
names of the business objects it generates.

JarFileDirectory |None String (Required) The directory where the .jar
files are located. All the jar files having
business functions that must be invoked
using the adapter must be placed in this
directory.

TraceFileName None String The name of the trace message file; for
example, OneWor1dODAtrace.txt.

Tracelevel 5 Integer (Required) The tracing level (from 0 to 5)

for the Agent. For details about tracing
levels, see|“Tracing” on page 44/
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Table 4. Configure Agent properties (continued)

Property name Default value | Type Description

MessageFile None String (required) The name of the message file

that contains all the messages displayed by
the ODA. For OneWorld, the name of this
file is BIA_OneWor1dODAAgent.txt. If you do
not correctly specify the name of the
message file, the ODA will generate an
€rTor.

Use the New and Save buttons in the Profiles group box any time you want
the ODA to create a new profile. When you use the ODA again, you can select
an existing profile.

Type the value of each property, as defined in [Table 4 on page 24}

Note: If you use a profile, the property values are filled in for you, though you
can modify the values as needed. You can also save new values.

Select a business object
The Business Object Wizard - Step 3 of 6 - Select Source screen appears, as illustrated
in [Figure 4 on page 26|

The following lists the rules associated with selecting objects for generation:

Selecting a parent object automatically selects the children objects for generation.
If you select the parent object as well as the children, then only the children
object that you select are generated.

Selecting a child object without selecting its parent causes the child object, but
not the parent, to be generated.

All child business objects are generated with single cardinality containment
relationships.

If a business object requires multiple cardinality behavior, then you must
manually change the cardinality using Business Object Designer Express.

The ODA does not mark the key fields of the business objects so you must
manually mark the key fields in the business object before saving.

You can select a .jar file for generation. This generates the definition of all the
interface and business function business objects contained in the jar file.

To determine which OneWorld objects listed on this screen are child objects of a
high-level object, refer to the original GenJava file. You can also simply select all
the OneWorld objects listed on this screen and generate their corresponding
business objects. The resulting business objects will reflect the parent-child
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relationships.

Business Object Wizard - Step 3 of 6 - Seleck

=10 x|

From the tree below, zelect the zource nodes from which the Dezigner will generate Bugsiness
Objects, Click "Mest" to continue,

|Jze thiz object instead I

El-- JDEAddressBookinterop. jar

Jar File

- AddressBook

Interface Class

----- DO100031 [GetM ailingM ame]

Data Structure Clazs

----- DO01000119 [GetABEffectiveD ate)

D ata Structure Class

------- D0100032 (GetPhone]

Data Structure Class

"""" DO100381 [GetParentAddressz]

Data Structure Class

"""" DO100033 [GetEffectiveAddressz]

Data Structure Class

[+ PurchaseOrderEntrylnterop. jar

Jar File

- S alesDrderE ntrylnterop.jar

Jar File

| ¥

¢ Back

MHewt » |

Cancel |

Figure 4. Select Source screen

1. If necessary, expand a OneWorld module to see a list of sub-objects.
2. Select the OneWorld object(s) you want to use.
3. Click Next.

Confirm the object selection
The Business Object Wizard - Step 4 of 6 - Confirm source nodes for business object
definitions screen appears. It shows the object(s) you selected.

For the business objects you generate using the ODA, you must manually mark
any key fields in Business Object Designer Express before saving the business
objects. The ODA does not mark any attributes as key fields.
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Business Object Wizard - Step 4 of b - Confir o ]

Buziness objects are about to be generated uzing the source nodes summarized below.
Click "Mext' to start generating the objects or click "Back'' to change vour selection.

M ame Drezcription
=1 Business Functions Buziness Function BO
=l JDEAddressE ooklnterop. jar Jar File

"""" AddrezsBook Interface Class
"""" DO100031 Data Structure Claszs
"""" DO100019 Data Structure Class
"""" DO100032 Data Structure Class
"""" Dol 00381 Data Structure Clazs
"""" DO100033 Data Structure Clazs

4| | vl

< Back I Hewt > I Cancel |

Figure 5. Confirm source node screen

Click Back to make changes or Next to confirm that the list is correct.

The Business Object Wizard - Step 5 of 6 - Generating business objects... screen appears
with a message stating that the wizard is generating the business objects.

Check the option to open the selected business object(s) in a separate window.

Specifying business object information

After you create a business object, you can specify the verbs that are valid for the
object, the method sequence of a given verb on the object, the business object-level
ASI, and the attribute-level ASI. This section describes how to specify this
information, using the ODA with Business Object Designer Express. For a detailed
description of these categories of information and what they mean for business
object structure in the JD Edwards OneWorld connector, see
[“Understanding business obijects,” on page 33)

Selecting verbs:

In Business Object Designer Express, the first screen that appears when you finish
creating a business object and then open it in a separate window is the BO
Properties - Select Verbs for component screen. [Figure 6 on page 28|illustrates this
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screen for the AddressBook business object.

: BO Properties - Capturing supported ¥erbs for seleq:':_' il

Property Value Type Description
1 AddressBook String Enter verk names using ; 55 a delimiter.

Figure 6. Select verb for component screen

On this screen you specify the verbs that the business objects supports. You can
specify the verbs that you need for a specific business object by typing the verb
names and delimiting them with a ;. The verb names must follow the naming
convention as specified in the Business Object Development Guide.

The standard verbs used in WebSphere Business Integration Server Express Plus
are Create, Retrieve, Delete, and Update. For details about business object verb
ASI for the OneWorld connector, see|“Verb ASI” on page 37

Specifying the verb ASI:

For each verb selected, a separate window appears where you specify the business
function sequence that must be executed for the verb.

[Figure 7 on page 29|illustrates this screen for the Retrieve verb of the AddressBook
business object created in [Figure 4 on page 26|and [Figure 5 on page 27|
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i BO Properties - Select the method sequence for C ﬂ

Property Value Type Description
1 Method=equence| GetEffectiveddress  [String Select the method for the sequence.
2 Method=equence | GetPhone String Select the method far the sequence.
3 Method=equence | Gethailingame String Select the method for the sequence.
4 Method=equence GetEffective.&ddresj String Select the method for the sequence.
3 |MethodZequence [ Gethsilingtame String Select the method for the sequence.
GetABEffectiveDate
GetEffectivedddress |

Figure 7. Setting the verb method sequence

1. In the Value list for the MethodSequence property, click the method that you
want the business object to execute first for the verb. In the method
sequence is as follows:

* The first method that will be executed in the sequence of methods for the
Retrieve verb is GetEffectiveAddress.

¢ The second method in the sequence is GetPhone.
* The third method in the sequence is GetMailingName.

By specifying a business function sequence for the verb, you are creating the
verb ASI that is associated with that verb. If necessary, this verb ASI can be
modified later.

2. Click OK.
Open the business object in a separate window:

The Business Object Wizard - Step 6 of 6 - Save business objects screen appears with
options to save a copy of the business objects to another file, to open the new

business objects in another window, and to shut down the OneWorld ODA. If you

choose to open the new business objects in another window, the Business Object

Designer Express displays a window where you can modify the attributes for those

business objects.
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=101 x|

Buzness objects were successfully created. You can zave their definition to the
zerver now or do it later if you wizh to ingpect them first.

[~ Save a copy of the business objects to a separate file

¥ Open the new BOs in separate windows

[~ Shutdown 008 Dnetworld0 D,

¢ Back Firizh Cancel

Figure 8. Save business objects screen

You must open the business object in a separate window within Business Object
Designer Express. After specifying a key for the top-level business object, save the
generated business object definitions to a file.

To open the business objects in separate windows:
1. Select Open the new BOs in separate windows. A dialog box appears.

2. Click Finish. Each business object appears in a separate window where you can
view and set the ASI information for the business objects and business object

verbs you just created. For details, see [“Specifying business object information”|
ﬂ

To save the business objects to a file (only after you a have specified a key for the
parent-level business object):

1. Select Save a copy of the business objects to a separate file. A dialog box
appears.

2. Type the location in which you want the copy of the new business object
definitions to be saved.

Business Object Designer Express saves the files to the specified location.

If you have finished working with the ODA, you can shut it down by checking
“Shutdown ODA JD Edwards OneWorld ODA” before clicking Finish.

Stopping the ODA

Stopping the ODA on Windows
If you have finished working with the ODA, you can shut it down by selecting the
Shutdown ODA JD Edwards OneWorld ODA check box before clicking Finish.
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Stopping the ODA on 0S/400
Stopping the ODA depends on the method used to start it.

If you started it using either method described in step 1 or step 2 in
ODA on OS/400” on page 22) do the following:

1. Run the CL Command: WRKACTJOB SBS(QWBISVR43). The screen shows all
of the jobs running in the subsystem.

2. Scroll through the list to find the job with a jobname that matches the job
description for the ODA. For the ODAName JD Edwards OneWorld ODA, it is
QWBIJDEODA.

3. Select option 4 and press F4 to prompt for the ENDJOB command and specify
*IMMED for the OPTION parameter.

4. Press enter.

If you started the ODA using step 3 in [“Starting the ODA on OS/400” on page 22
press the F3 key where you ran the start_ ODAName.sh script

Uploading business object files

The newly created business object definition files must be uploaded to InterChange
Server Express once they have been created.

* InterChange Server Express: If you have saved your business object definition
files to a local machine and need to upload them to the repository on the server,
refer to the Implementation Guide for WebSphere InterChange Server Express.
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Chapter 5. Understanding business objects

This chapter describes the structure of business objects, how the adapter processes
the business objects, and the assumptions the adapter makes about them.

The chapter contains the following sections:

* |"Defining metadata”|

+ [“Connector business object structure” on page 34|

» [“Sample business object properties” on page 38|

* [“Generating business objects” on page 41|

Defining metadata

The connector for JD Edwards OneWorld is metadata-driven. In the WebSphere
business integration system, metadata is defined as application-specific information
that describes a OneWorld application object’s data structures. The metadata is
used to construct business object definitions that the connector uses at runtime to
build business objects.

After installing the connector, but before you can run it, you must create the
business objects definitions. The business objects that the connector processes can
have any name allowed by InterChange Server Express. For information about
naming conventions, see the Naming Components Guide.

A metadata-driven connector handles each business object that it supports
according to the metadata encoded in the business object definition. This enables
the connector to handle new or modified business object definitions without
requiring modifications to the code. New objects are created in Business Object
Designer Express, with or without the assistance of the ODA. To modify an
existing object, use Business Object Designer Express directly (the ODA cannot be
used to modify an existing business object).

Application-specific metadata includes the structure of the business object and the
settings of its attribute properties. Actual data values for each business object are
conveyed in message objects at run time.

The connector makes assumptions about the structure of its supported business
objects, the relationships between parent and child business objects, and the format
of the data. Therefore, it is important that the structure of the business object
exactly mirror the structure defined for the corresponding JD Edwards OneWorld
object or the adapter will not be able to process business objects correctly.

If you need to make changes to the business object structure, make them to the
corresponding object in OneWorld and then run GenJava to create jar files that can
be used as an input into the ODA.

For more information on modifying business object definitions, see WebSphere

Business Integration Server Express and Express Plus Adapters Business Object
Development Guide.
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Connector business object structure

Each OneWorld object has a corresponding business object.

The business objects for the JD Edwards OneWorld adapter can be of two types to
support the Java APIs as well as the XMLList APIs from OneWorld. The current
release of the adapter does not support XMLList business objects.

The business objects that are processed using Java APIs have a type=BFN tag in the
business object ASI that distinguishes them from XMLList business objects. Within
the business objects that are used for Java APIs, there are two types of business
objects that map to the Interface class and business objects that map to a business
function class. The business objects that map to the Interface class have ASI as
follows:

type=BFN;class_name=com.JD Edwards.interop.AddressBook.JDEAddressBook

All the business functions present in the class JDEAddressBook and present in the
jar file generated by GenJava are represented as child business objects to the main
business object. All the child business objects for a top-level business object must
map to business functions that can be access through one username and password.
If a specific business function has a different username/password access, then that
must be part of a separate business object hierarchy that has access to that
username/password. Refer to [“Business functions” on page 35| for further details
on how to define special access permissions for a business object.

Each data structure class present in the .jar file, generated from GenJava, maps to
the corresponding business object. For example, in the JDEAddressBook example,
the data structure names are:

D0100031

D0100019

D0100032

D0100002
D0100033

And, they map to Interface business objects and child business objects created for
B0O100031, BO100019, etc.

The ASI for the above business objects has a tag for name= where the value is the
name of the data structure. It also has a tag, bfn_name=, for the name of the
business function that corresponds to these business objects.

The name of the attribute maps to the name of the method that is represented by
the business object. For example, if the data structure is D0100033, the name of the
attribute in the AddressBook business object would be GetEffectiveAddress. The
ASI at this attribute level would give the name of the method using the ASI tag
bfn_name=.

Attributes

For each attribute present in the Data Structure class, a corresponding business
object attribute is generated in the business function business object. The ASI for
the attribute holds information about its type and name in OneWorld. For example,
if the attribute type is JDEDate, then the ASI holds
“name=EffectiveDate;type=JDEDate”. Besides some simple types of attributes,
OneWorld supports two proprietary data types, JDEDate and JDEMathNumeric.
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JDEDate

The following methods are available in this OneWorld Java class:
e JDEDate() — constructor

* GetDay() — returns the day of the date

e GetMonth() — returns the month of the date.

* GetYear() — returns the year of the date.

» SetDay(short) — set the day of the date

e SetMonth(short) — set the month of the date

* SetYear(short) — set the year of the date

The values for attributes that map to OneWorld date fields are specified in the
format MM/DD/YYYY. The adapter parses this string value and calls OneWorld APIs
on the JDEDate object to set values for the day, month, and year. If the data from
OneWorld has to be set in the business object, it uses the get methods to set value
in the attribute.

JDEMathNumeric

The following methods are present in the JDEMathNumeric class:
* GetValue() — returns the value as a String, for example, 12345.6789
+ SetValue() — sets the value from a String, for example 12345.6789"

Business object attribute types

The following table lists the data types supported by OneWorld and the
corresponding type in a WebSphere Business Integration Server Express Plus
business object.

Table 5. Business object attribute types

Business object
OneWorld type attribute type ASI
JDEDate Date type=JDEDate
JDEMathNumeric Integer type=JDEMathNumeric
int Integer type=int
booTean Boolean type=boolean
char String type=char
String String type=String
short Integer type_short
float Float type=float
doubTe Double type=double
byte String type=byte
long Integer type=long

Business functions

The OneWorld connector invokes all of the business functions in one doVerbFor()
call in one transaction. If one of them fails, all of them will be rolled back. All the
business functions within one business object execution must have access
permissions from a single user. The user can be one that is created for the adapter
and is maintained as a connection pool or it can be a specific user. You can specify
a user for a business object by using a child business object of single cardinality
with the type ACCESS_LEVEL.
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For proper representation of business function calls, the business function is
modeled as a child business object containing attributes that represent data
structure variables.

The adapter supports the business objects that map to business functions to be
executed independently. For all such business objects, the ASI contains the
information required to execute the business function, for example, business
function name, and the name for the data structure. The ASI for a business
function business object, as above, can be represented as follows:
bfn_name=getEffectiveAddress

type=BFN

name=com.JD Edwards.interop.D0100031

Custom business functions

The following custom business functions are included and required for
implementation of event notification in the adapter:

* Retrieve WBIAEvents — The name of the business function that retrieves the
records from the IBM events table.

* Update_WBIAEvents — The name of the business function that updates the
records from the IBM events table.

* Delete_WBIAEvents — The name of the business function that deletes the records
from the IBM events table.

e Archive WBIAEvents — The name of the business function that archives the
records from the IBM events table to the archive table.

* Recover_WBIAEvents — The name of the business function that retrieves the
IN_PROGRESS events and changes the status to READY_FOR_POLL.

Events business object structure
The following table details the event notification features supported by the
connector.

Table 6. Event table structure

Columns Description

0BJ_KEY The unique identifier that identifies the business object row for
which the event was created. If there are multiple attributes in a
business object that make a key then the values are name value

7z

pairs delimited by “;

If the business object is of type business function, then the object
key should be as follows: DS0013keyattrl=123;
DS0013keyattr2=124. If the verb ASI for the retrieve verb
specifies multiple business functions, you might need to set
multiple key fields. That is supported since the adapter is using
the data structure name along with the attribute name, for
example, DO013.attrl1=123;D0012.attr1=345.

0BJ_NAME OneWorld business object for which the event was detected.
0BJ_VERB Verb for the event.

EVT_PRIORITY Event priority.

EVT_STATUS Event status. Initially set to READY_FOR_POLL.

EVT_DESC Any comment associated with the event.

EVENT_ID Unique ID of the event row.

ADAPTER_ID Identifies the connection in a multiple connector configuration.
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Table 6. Event table structure (continued)

Columns Description

EVT_TIME Event creation timestamp.

Application-specific information

Application-specific information provides the connector with application-
dependent instructions on how to process business objects. If you extend or modify
a business object definition, you must make sure that the application-specific
information in the definition matches the syntax that the connector expects.

Application-specific information can be specified for the overall business object as
well as for each business object attribute.

Business object-level ASI

Object-level ASI provides fundamental information about the nature of a business
object and the objects it contains. Business object ASI is in name-value pairs.
Business objects that represent interface objects recognize the following ASI names:

 type=BFN if the adapter invokes a business function.

* class_name=com.JD Edwards.interop.AddressBook, which is the name of the
interface class.

Business objects map to business functions that are executed individually. For
business objects that represent business functions, the adapter recognizes the
following names:

* type=BFN if the adapter invokes a business function
* bfn _name=getEffectiveAddress

* name=com.JD Edwards.interop.D0100031, which is the name of the structure
class.

Verb ASI

For business objects that map to the Interface class, the Verb ASI contains a
sequence of attribute names that map to business functions for the OneWorld BO
Handler to call. The adapter invokes business functions in the sequence specified
by the Verb ASI.

For business objects that map to business functions, the Verb ASI is blank.

Attribute-level ASI

The business objects that map to business functions have attributes that map to the
get<Attr>/set<Attr> method combinations of the data structure class. The
connector takes this data structure object as an input parameter when the function
is invoked. For all such attributes, ASI stores the type of the attribute as
type=<type> and the actual name of the attribute as name=<name>. The adapter
generates only one attribute for a combination of get/set. For example, if an
attribute name is ID, the methods would be getID() and setID(). The business
object would have one attribute with name ID and ASI as
getter=getID();setter=setID(), type=int, name=1ID.
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describes the ASI for non-method attributes.
Table 7. Attribute-level ASI for non-method attributes

Attribute Description

Name Specifies the business object field name
Type Specifies the business object field type
MaxLength 255 characters, by default

IsKey Set to false.

IsForeignKey

Set to false.

IsRequired

Set to false. Set to true if the field is mandatory.

AppSpecificInfo |This attribute is formatted as follows:
name=; type=; use_attribute_value=busobj.attrname(optional);
getter=; setter=;

DefaultValue None

describes the ASI for non-method attributes.
Table 8. Attribute-level ASI for method attributes

Attribute Description

Name Specifies the business object field name

Type Specifies the business object field type

Relationship If the child is a container attribute, this is set to Container.
IsKey Set to false.

IsForeignKey Set to false.

IsRequired Set to false.

AppSpecificInfo |None

Cardinality 1

Sample business object properties

This section provides an example of a WebSphere Business Integration Server
Express Plus business object. The corresponding OneWorld class and Java class are
also provided to illustrate the mapping across the three constructs. Note that
business objects inherit their names from the matching OneWorld application

objects.

The samples provided in this section are as follows:

“Sample GenJava script file”|

* |“Business object structure for the above example” on page 40|

Sample GendJava script file

OneWorld provides a utility, GenJava, that generates Java wrappers for the
business functions running as part of the OneWorld server. GenJava requires a
script file, written using iJDEScript. The following example uses the script file,
AddressBook.cmd. AddressBook.cmd specifies the library and the interface to which
the set of business functions is modularized.
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Once GenJava is executed, it creates Java class files for all the interface classes and
associated data structures. GenJava compiles the generated Java files, generates
Java docs, and packages them into two jar files, one for Java classes and one for
Java doc. The below sample renders AddressBookInterop.jar and
AddressBookInteropDoc.jar files.

To execute the following sample, type the following from the command line:
GenJava /UserID JDE /Password JDE /Environment JDETest /cmd AddressBook.cmd

There are options available for running GenJava. GenJava is present in the
<INSTALL>\system\bin32 folder.

Please refer to the section on Running GenJava in the Interoperability Guide,
provided by OneWorld. The sample GenJava script file is shown below:

# This example creates a library whose name is derived from an input parameter
# (library) if one is specified. A default value is used otherwise.

define library JDEAddressBook
login

library JDEAddressBook
interface AddressBook
import B0100031
import B0100019
import B0100032
import B0100002
import B0100033
build

logout

While preparing this script, consider the mapping of the Interface class to a
business object in the WebSphere Business Integration Server Express Plus Adapter
and relate the business functions as method sequences that are required for
performing the intended actions for a verb. For example, if a business object is a
SalesOrder business object, then the interface SalesOrder in the script file must
include all the business functions that it needs to perform actions on the
SalesOrder object through the WebSphere Business Integration Server Express Plus
Adapter. The sequence of method execution for each verb is accomplished by
populating the verb ASI for the business object. You must be able to do this in the
business object generation process using the ODA. You can also edit the verb ASI
using Business Object Designer Express after the business objects have been
generated.
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Business object structure for the above example

The following figure shows the business object structure for the above example in
Business Object Designer Express.
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Figure 9. Business object structure for the AddressBook example

This section explains the business object structure for the AddressBook example, in
the following sections:

AddressBook

Name AddressBook
ASI (type=BFN; class_name=com.JD Edwards.interop.AddressBook)

Attributes

The AddressBook business object includes the following objects:
* GetMailingName (Object)

* GetABEffectiveDate (Object)

* GetPhone (Object)

* GetParentAddress (Object)

* GetEffectiveAddress (Object)

Verb ASI
The Verb ASI uses the following Retrieve and RetrieveDetails objects:

* Retrieve — GetEffectiveAddress
* RetrieveDetails — GetPhone; GetMailingName
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D0100033

Name D0100033

AST (type=BFN;

class_name=com.JD Edwards.interop.jdeaddressbook.D0100033;
bfn_name=GetEffectiveAddress)

Attributes

The D0100033 business object includes the following objects:

* mnAddressNumber (Integer)
(ASI) type = JDEMathNumeric; name = m_mnAddressNumber;
use_attribute_value=;getter=getmnAddressNumber;setter=;

» jdDateBeginningEffective (Date)
(ASI) type = JDEDate; name = m_mnAddressNumber;
use_attribute_value=;getter=getjdDateBeginningEffective;
setter=setjdDateBeginningEffective;

Verb ASI

None.

Generating business objects

Each time an event occurs during run time, a OneWorld application sends a
message object containing object-level data and information about the type of
transaction. The connector maps this data to the corresponding business object
definition, to create an application-specific business object. The connector sends
these business objects on to InterChange Server Express for processing. It also
receives business objects back from InterChange Server Express, which it passes
back to the OneWorld application.

Note: If the object model in the OneWorld application is changed, use the ODA to
create a new definition. If the business object definitions in InterChange
Server Express repository do not exactly match the data that the OneWorld
application sends, the connector is not able to create a business object and
the transaction fails.

Business Object Designer Express provides a graphical interface that enables you to
create and modify business object definitions for use at run time. For details, see
[Chapter 4, “Creating and modifying business objects,” on page 21
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Chapter 6. Error handling

This chapter describes how the adapter for JD Edwards OneWorld handles errors.
The adapter generates logging and tracing messages. This chapter describes these
messages. The chapter contains the following sections:

* [“Error handling”]|

* |"Logging”]
* |“Tracing” on page 44

Error handling

This section describes error handling for the OneWorld adapter and the OneWorld
ODA.

Adapter

ODA

All messages generated by the connector are stored in a message file. Each
message has a message number followed by the message:

Message number
Message text

The connector handles additional specific errors as described in the following
sections.

The OneWorld ODA throws an exception in the following scenarios:

* If the path specified for the .jar file does not exist or cannot be accessed
* If the jar file is corrupt or cannot be accessed

e If the jar file is empty

ODK properties define the trace file name and trace level. The ODK wizard
manages these two properties. The trace file can be found in the OneWorld folder
of the Crossworlds/ODA folder. The default name of the file

is OneWorldODAtrace.txt. The message file containing the error and trace messages
has the following naming convention:

BIA <ODAAgentName>Agent.txt

ODAAgentName is the value from the variable of the same name found in the start
file for the ODA. If you change the value of the ODAAgentName variable, then you
must also change the message file name. The error and trace message file is in the
ODA messages folder.

See Tracing Exceptions and Messages in the Business Object Development Guide for
more information on the trace file and the message file.

Logging

All messages are read from the message files BIA_<ODAAgentName>Agent.txt for the
ODA and BIA_OneWorldAdapter.txt for the connector.
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Tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. For more
on configuring trace messages, see the connector configuration properties in

[“Configuring the connector” on page 13|For more information on tracing,

including how to enable and set it, see the Connector Development Guide.

lists the recommended content for connector tracing message levels.

Table 9. Tracing messages content

Level

Description

Level 0

This level is used for trace messages that identify the connector version. No
other tracing is performed at this level.

Level 1

Use this level for trace messages that:

Provide status information.
Provide key information on each business object processed.

Record each time a polling thread detects a new message in an input
queue.

Level 2

Use this level for trace messages that:

Identify the BO handler used for each object that the connector processes.
Log each time a business object is posted to InterChange Server Express.

Indicate each time a request business object is received.

Level 3

Use this level for trace messages that:

Identify the sub-objects being processed, if applicable. These messages
appear when the connector has encountered a foreign key in a business
object or when the connector sets a foreign key in a business object.

Relate to business object processing. Examples of this include finding a
match between business objects, or finding a business object in an array
of child business objects.

Level 4

Use this level for trace messages that:

Identify application-specific information. Examples of this include the
values returned by the methods that process the application-specific
information fields in business objects.

Identify when the connector enters or exits a function. These messages
help trace the process flow of the connector.

Record any thread-specific processing. For example, if the connector
spawns multiple threads, a message logs the creation of each new thread.

Level 5

Use this level for trace messages that:

Indicate connector initialization. This type of message can include, for
example, the value of each connector configurator property that has been
retrieved from the broker.

Detail the status of each thread that the connector spawns while it is
running.

Represent statements executed in the application. The connector log file
contains all statements executed in the target application and the value of
any variables that are substituted, where applicable.

Record business object dumps. The connector should output a text
representation of a business object before it begins processing (showing
the object that the connector receives from the collaboration) as well as
after it finishes processing the object (showing the object that the
connector returns to the collaboration).
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Enabling the connector to work with a DB2 database

Reviewers: This is a section that I added; it may not be valid/apply to this
adapter guide. Please verify if it should remain or be deleted. The information is
specific to JDBC. If this section remains in the book, please supply information
specific to the SE adapter for JD Edwards. I would also need OS/400
information.

Before you can use the connector with a DB2 database, you must perform the
following steps:

I— Existing Windows procedure here

If you specify the value of the connector’s JDBCDriverClass property to
COM.ibm.db2.jdbc.net.DB2Driver, then first do the following steps:

1.

Copy the file named db2java.zip and db2jcc.jar from the DB2 directory, for
example, /opt/IBM/db2/v8.1/java, to the $Product/Dir/lib directory on the
machine on which the connector is going to run.

Copy the file named 1ibdb2jdbc.so from the DB2 directory, for example,
/opt/IBM/db2/v8.1/11b, to the $ProductDir/bin directory on the machine on
which the connector is going to run.

Change the following in the connector’s startup file start_JDBC.sh:
JDBCDRIVERPATH="${CROSSWORLDS}/1ib/db2java.zip:${CROSSWORLDS}/
lib/db2jcc.jar"

Set the value of the connector’s DatabaseURL property to
jdbc:db2://MachineName:PortNumber/DBname.

On the DB2 host machine, start the /opt/IBM/db2/v8.1/bin/db2jstrt process.
Be sure to specify the number of the port you are using.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of the adapters in WebSphere Business Integration Server Express,
running on WebSphere InterChange Server Express.

Not every connector makes use of all these standard properties. When you select
an integration broker from Connector Configurator Express, you will see a list of
the standard properties that you need to configure for your adapter.

For information about properties specific to the connector, see the relevant adapter
user guide.

Configuring standard connector properties

Adapter connectors have two types of configuration properties:
¢ Standard configuration properties
 Connector-specific configuration properties

This section describes the standard configuration properties. For information on
configuration properties specific to a connector, see its adapter user guide.

Using Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the Connector Configurator Express appendix.

Setting and updating property values
The default length of a property field is 255 characters.

The connector uses the following order to determine a property’s value (where the
highest number overrides other values):

1. Default

2. Repository

3. Local configuration file
4. Command line

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s Update
Method determines how the change takes effect. There are four different update
methods for standard connector properties:
* Dynamic
The change takes effect immediately after it is saved in System Manager.
* Component restart
The change takes effect only after the connector is stopped and then restarted in
System Manager. You do not need to stop and restart the application-specific
component or the integration broker.
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* Server restart
The change takes effect only after you stop and restart the application-specific
component and the integration broker.

* Agent restart
The change takes effect only after you stop and restart the application-specific
component.

To determine how a specific property is updated, refer to the Update Method

column in the Connector Configurator Express window, or see the Update Method

column in the Property Summary table below.

Summary of standard properties

provides a quick reference to the standard connector configuration
properties. Not all the connectors make use of all these properties, and property
settings may differ from integration broker to integration broker, as standard
property dependencies are based on RepositoryDirectory.

You must set the values of some of these properties before running the connector.
See the following section for an explanation of each property.

Table 10. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
IAdminIng gueugl Valid JMS queue name CONNECTORNAME /ADMININQUEUE Component | Delivery
restart Transport is
JMS
AdminOutQueue) Valid JMS queue name CONNECTORNAME/ADMINOUTQUEUE [ Component | Delivery
restart Transport is
MS
1-4 1 Component | Delivery
restart Transport is
IDL
0-5 0 Dynamic
Application name Value specified for the Component
connector application name restart
BrokerType 1Cs ICS
|CharacterEncoding] ascii7, ascii8, SJIS, ascii7 Component
Cp949, GBK, Big5h, restart
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
Note: This is a subset
of supported
values.
|ConcurrentEventTriggeredFlowsd 1 to 32,767 1 Component | Repository
restart directory
is
<REMOTE>
|ContainerManagedEvents| No value or JMS No value Component | Delivery
restart Transport is
MS
|ControllerStoreAndForwardModed | true or false truetrue Dynamic Repository
directory
is
<REMOTE>
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|ControllerTraceLevel| 0-5 0 Dynamic Repository
directory
is
<REMOTE>
CONNECTORNAME/DELIVERYQUEUE | Component |JMS transport
| restart only
|DelivervTranspora IDL or JMS DL Component
restart
|DuplicateEventElimination true or false false Component | JMS transport
restart only: Container
Managed Events
must be
<NONE>
|[EnableOidForFlowMonitoring] true or false false Component
restart
|Fault£ 2ueug| CONNECTORNAME / FAULTQUEUE Component | JMS
restart transport
only
hms.FactoryClassNamd CxCommon.Messaging.jms | CxCommon.Messaging. Component | JMS transport
. IBMMQSeriesFactory jms.IBMMQSeriesFactory restart only
or any Java class name
hms.MessageBrokerNamd crossworlds.queue. crossworlds.queue.manager Component | JMS transport
manager restart only
|jmslNumConcurrentRequestS| Positive integer 10 Component | JMS transport
restart only
Any valid password Component | JMS transport
restart only
Any valid name Component | JMS transport
restart only
[]vm MaxHeapSize| Heap size in megabytes 128m Component | Repository
restart directory
is
<REMOTE>
lvmMaxNativeStackSize| Size of stack in kilobytes | 128k Component | Repository
restart directory
is
<REMOTE>
lvmMinHeapSize| Heap size in megabytes Im Component | Repository
restart directory
is
<REMOTE>
ILocald] en_US, ja_JP, ko KR, en_US Component
zh_CN, zh_TW, fr_FR, restart
de_DE,
it_IT, es_ES, pt_BR
Note: This is a
subset of the
supported
locales.
|Log AtInterchangeEnd| true or false false Component
restart
[IMaxEventCapacity| 1-2147483647 2147483647 Dynamic Repository
Directory is
<REMOTE>
||MessageFileNamg| Path or filename InterchangeSystem.txt Component
restart
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
Any valid queue name | CONNECTORNAME/MONITORQUEUE | Component |JMS transport
restart only:
DuplicateEvent
Elimination
must be true
[OADAutoRestartAgent| true or false false Dynamic Repository
Directory is
<REMOTE>
|OADMaxNumRetry| A positive number 1000 Dynamic Repository
Directory is
<REMOTE>
|OADRetryTimelntervall A positive number in 10 Dynamic Repository
minutes Directory is
<REMOTE>
IPollEndTimgI HH:MM HH:MM Component
(HH is 0-23, MM is 0-59) restart
[PollFrequency] A positive integer in 10000 Dynamic
milliseconds
no (to disable polling)
key (to poll only when
the letter p is entered in
the connector’s
Command Prompt
window)
PollQuanti 1-500 1 Agent JMS transport
restart only:
Container
Managed
Events is
specified
PollStartTime HH:MM(HH is 0-23, MM is | HH:MM Component
0-59) restart
Location of metadata Agent Set to
repository restart <REMOTE>
Valid JMS queue name CONNECTORNAME /REQUESTQUEUE Component | Delivery
restart Transport is
JMS
[ResponseQueud Valid JMS queue name CONNECTORNAME/RESPONSEQUEUE | Component | Delivery
restart Transport is
JMS:
[RestartRetryCount| 0-99 3 Dynamic
A sensible positive 1 Dynamic
value in minutes:
1 - 2147483547
ISourceQueuel Valid JMS queue name | CONNECTORNAME/SOURCEQUEUE Agent Only if
restart Delivery
Transport is
JMS and
Container
Managed
Events is
specified
[SynchronousRequestQueue| Valid JMS queue name | CONNECTORNAME/ Component | Delivery
SYNCHRONOUSREQUESTQUEUE restart Transport is

TMS
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Table 10. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|SynchronousRequestTimeout| 0 - any number (millisecs) | 0 Component | Delivery
restart Transport is
JMS
|SynchronousResponseQueud Valid JMS queue name CONNECTORNAME/ Component | Delivery
SYNCHRONOUSRESPONSEQUEUE restart Transport is
JMS
CwBO CwBO Agent
restart

Standard configuration properties

This section lists and defines each of the standard connector configuration
properties.

AdmininQueue

The queue that is used by the integration broker to send administrative messages
to the connector.

The default value is CONNECTORNAME /ADMININQUEUE.

AdminOutQueue

The queue that is used by the connector to send administrative messages to the
integration broker.

The default value is CONNECTORNAME /ADMINOUTQUEUE.

AgentConnections

The AgentConnections property controls the number of ORB connections opened
by orb.init[].

By default, the value of this property is set to 1. There is no need to change this
default.

AgentTracelLevel

Level of trace messages for the application-specific component. The default is 0.
The connector delivers all trace messages applicable at the tracing level set or
lower.

ApplicationName

Name that uniquely identifies the connector’s application. This name is used by
the system administrator to monitor the WebSphere business integration system
environment. This property must have a value before you can run the connector.

BrokerType

Identifies the integration broker that you are using, which is ICS.

CharacterEncoding

Specifies the character code set used to map from a character (such as a letter of
the alphabet, a numeric representation, or a punctuation mark) to a numeric value.
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Note: Java-based connectors do not use this property. A C++ connector currently
uses the value ascii7 for this property.

By default, a subset of supported character encodings only is displayed in the drop
list. To add other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

ConcurrentEventTriggeredFlows

Determines how many business objects can be concurrently processed by the
connector for event delivery. Set the value of this attribute to the number of
business objects you want concurrently mapped and delivered. For example, set
the value of this property to 5 to cause five business objects to be concurrently
processed. The default value is 1.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), you must:

* Configure the collaboration to use multiple threads by setting its Maximum number
of concurrent events property high enough to use multiple threads.

* Ensure that the destination application’s application-specific component can
process requests concurrently. That is, it must be multi-threaded, or be able to
use connector agent parallelism and be configured for multiple processes. Set the
Parallel Process Degree configuration property to a value greater than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and performed serially.

ContainerManagedEvents

This property allows a JMS-enabled connector with a JMS event store to provide
guaranteed event delivery, in which an event is removed from the source queue
and placed on the destination queue as a single JMS transaction.

This property only appears if the DeliveryTransport property is set to the value
JMS.

The default value is No value.

When ContainerManagedEvents is set to JMS, you must configure the following
properties to enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = CONNECTORNAME/SOURCEQUEUE

You must also configure a data handler with the MimeType, DHClass, and
DataHandlerConfigMOName (optional) properties. To set those values, use the
Data Handler tab in Connector Configurator Express. The fields for the values
under the Data Handler tab will be displayed only if you have set
ContainerManagedEvents to JMS.
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Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pol1ForEvents() method, thereby disabling that method’s functionality.

ControllerStoreAndForwardMode

Sets the behavior of the connector controller after it detects that the destination
application-specific component is unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

The default is true.

ControllerTraceLevel
Level of trace messages for the connector controller. The default is 0.

DeliveryQueue
Applicable only if DeliveryTransport is JMS.

The queue that is used by the connector to send business objects to the WebSphere
InterChange Server Express.

The default value is CONNECTORNAME/DELIVERYQUEUE.

DeliveryTransport

Specifies the transport mechanism for the delivery of events. Possible values are
IDL for CORBA IIOP or JMS for Java Messaging Service. The default is IDL.

The connector sends service call requests and administrative messages over
CORBA IIOP if the value configured for the DeliveryTransport property is IDL.

JMS

Enables communication between the connector and client connector framework
using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as
Jjms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName,
appear in Connector Configurator Express. The first two of these properties are
required for this transport.

Important: There may be a memory limitation if you use the JMS transport

mechanism for a connector running on WebSphere InterChange Server
Express.
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In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client.

DuplicateEventElimination

When you set this property to true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, the
connector must have a unique event identifier set as the business object’s
ObjectEventld attribute in the application-specific code. This is done during
connector development.

This property can also be set to false.

Note: When DuplicateEventElimination is set to true, you must also configure
the MonitorQueue property to enable guaranteed event delivery.

EnableOidForFlowMonitoring

When you set this property to true, the adapter framework will mark the
incoming ObjectEventld as a foreign key for the purpose of flow monitoring.

The default is false.

FaultQueue

If the connector experiences an error while processing a message then the
connector moves the message to the queue specified in this property, along with a
status indicator and a description of the problem.

The default value is CONNECTORNAME/FAULTQUEUE.

JvmMaxHeapSize
The maximum heap size for the agent (in megabytes).

The default value is 128m.

JvmMaxNativeStackSize

The maximum native stack size for the agent (in kilobytes).

The default value is 128k.

JvmMinHeapSize

The minimum heap size for the agent (in megabytes).

The default value is 1m.

jms.FactoryClassName

Specifies the class name to instantiate for a JMS provider. You must set this
connector property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.
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jms.MessageBrokerName

Specifies the broker name to use for the JMS provider. You must set this connector
property when you choose JMS as your delivery transport mechanism (see
DeliveryTransport).

The default is crossworlds.queue.manager.

jms.NumConcurrentRequests

Specifies the maximum number of concurrent service call requests that can be sent
to a connector at the same time. Once that maximum is reached, new service calls
block and wait for another request to complete before proceeding.

The default value is 10.

jms.Password
Specifies the password for the JMS provider. A value for this property is optional.

There is no default.

jms.UserName
Specifies the user name for the JMS provider. A value for this property is optional.

There is no default.

Locale

Specifies the language code, country or territory, and, optionally, the associated
character code set. The value of this property determines such cultural conventions
as collation and sort order of data, date and time formats, and the symbols used in
monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

ll a two-character language code (usually in lower
case)

T a two-letter country or territory code (usually in
upper case)

codeset the name of the associated character code set; this

portion of the name is often optional.

By default, only a subset of supported locales appears in the drop list. To add
other supported values to the drop list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on using Connector Configurator Express in this guide.

The default value is en_US. If the connector has not been globalized, the only valid
value for this property is en_US. To determine whether a specific connector has

been globalized, see the connector version list on these websites:

http:/ /www.ibm.com/software/websphere/wbiadapters/infocenter, or
http:/ /www.ibm.com /websphere/integration/wicserver/infocenter
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LogAtinterchangeEnd

Specifies whether to log errors to the integration broker’s log destination. Logging
to the broker’s log destination also turns on e-mail notification, which generates
e-mail messages for the MESSAGE_RECIPIENT specified in the InterchangeSystem.cfg
file when errors or fatal errors occur.

For example, when a connector loses its connection to its application, if
LogAtInterChangeEnd is set to true, an e-mail message is sent to the specified
message recipient. The default is false.

MaxEventCapacity

The maximum number of events in the controller buffer. This property is used by
flow control.

The value can be a positive integer between 1 and 2147483647. The default value is
2147483647.

MessageFileName

The name of the connector message file. The standard location for the message file
is \connectors\messages. Specify the message filename in an absolute path if the
message file is not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a specific connector has its own message file, see the
individual adapter user guide.

MonitorQueue

The logical queue that the connector uses to monitor duplicate events. It is used
only if the DeliveryTransport property value is J]MS and
DupTicateEventETimination is set to TRUE.

The default value is CONNECTORNAME /MONITORQUEUE

OADAutoRestartAgent

Specifies whether the connector uses the automatic and remote restart feature. This
feature uses the MQ-triggered Object Activation Daemon (OAD) to restart the
connector after an abnormal shutdown, or to start a remote connector from System
Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the MQ-triggered OAD feature, see
the Installation Guide for Windows.

The default value is false.

OADMaxNumRetry

Specifies the maximum number of times that the MQ-triggered OAD automatically
attempts to restart the connector after an abnormal shutdown. The
OADAutoRestartAgent property must be set to true for this property to take effect.
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The default value is 1000.

OADRetryTimelnterval

Specifies the number of minutes in the retry-time interval for the MQ-triggered
OAD. If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this property
to take effect.

The default is 10.

PollIEndTime

Time to stop polling the event queue. The format is HH:MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

PollFrequency

The amount of time between polling actions. Set Po11Frequency to one of the
following values:

* The number of milliseconds between polling actions.

* The word key, which causes the connector to poll only when you type the letter
p in the connector’'s Command Prompt window. Enter the word in lowercase.

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. To
determine whether a specific connector does, see the installing and
configuring chapter of its adapter guide.

PollQuantity

Designates the number of items from the application that the connector should poll
for. If the adapter has a connector-specific property for setting the poll quantity, the
value set in the connector-specific property will override the standard property
value.

PollStartTime

The time to start polling the event queue. The format is HH: MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

RequestQueue

The queue that is used by WebSphere InterChange Server Express to send business
objects to the connector.

The default value is CONNECTOR/REQUESTQUEUE.
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RepositoryDirectory

The location of the repository from which the connector reads the XML schema
documents that store the meta-data for business object definitions.

This value must be set to <REMOTE> because the connector obtains this
information from the InterChange Server Express repository.

ResponseQueue
Applicable only if DeTiveryTransport is JMS.

Designates the JMS response queue, which delivers a response message from the
connector framework to the integration broker. WebSphere InterChange Server
Express sends the request and waits for a response message in the JMS response
queue.

RestartRetryCount

Specifies the number of times the connector attempts to restart itself. When used
for a parallel connector, specifies the number of times the master connector
application-specific component attempts to restart the slave connector
application-specific component.

The default is 3.

RestartRetryinterval

Specifies the interval in minutes at which the connector attempts to restart itself.
When used for a parallel connector, specifies the interval at which the master
connector application-specific component attempts to restart the slave connector
application-specific component. Possible values ranges from 1 to 2147483647.

The default is 1.

SourceQueue

Applicable only if DeliveryTransport is JMS and ContainerManagedEvents is
specified.

Designates the JMS source queue for the connector framework in support of
guaranteed event delivery for JMS-enabled connectors that use a JMS event store.
For further information, see [’ContainerManagedEvents” on page 52

The default value is CONNECTOR/SOURCEQUEUE.

SynchronousRequestQueue
Applicable only if DeliveryTransport is JMS.

Delivers request messages that require a synchronous response from the connector
framework to the broker. This queue is necessary only if the connector uses
synchronous execution. With synchronous execution, the connector framework
sends a message to the SynchronousRequestQueue and waits for a response back
from the broker on the SynchronousResponseQueue. The response message sent to
the connector bears a correlation ID that matches the ID of the original message.

The default is CONNECTORNAME/SYNCHRONOUSREQUESTQUEUE
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SynchronousResponseQueue
Applicable only if DeliveryTransport is JMS.

Delivers response messages sent in reply to a synchronous request from the broker
to the connector framework. This queue is necessary only if the connector uses
synchronous execution.

The default is CONNECTORNAME/SYNCHRONOUSRESPONSEQUEUE

SynchronousRequestTimeout
Applicable only if DeTiveryTransport is JMS.
Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified time, then
the connector moves the original synchronous request message into the fault queue

along with an error message.

The default value is 0.

WireFormat

This is the message format on the transport. The setting isCwBO0.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

The topics covered in this appendix are:

+ [“Overview of Connector Configurator Express” on page 61|

* |“Starting Connector Configurator Express” on page 62

» |“Creating a connector-specific property template” on page 62|

* |“Creating a new configuration file” on page 65

* |[“Setting the configuration file properties” on page 67|

» [“Using Connector Configurator Express in a globalized environment” on page|

72

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with WebSphere InterChange Server Express.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and maps for use with collaborations as well as specify messaging,
logging and tracing, and data handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 63[to set up a new one.
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Note: Connector Configurator Express runs only in a Windows environment. If
you are running the connector in another environment, use Connector
Configurator Express in Windows to modify the configuration file and then
copy the file to the other environment.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
e From System Manager

Running Configurator Express in stand-alone mode

You can run Connector Configurator Express independently and work with
connector configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere Business Integration Server
Express> Toolset Express>Development>Connector Configurator Express.

* Select File>New>Configuration File.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see[“Completing a configuration file” on page 67)

Running Configurator Express from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:
1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

To edit an existing configuration file:

1. In the System Manager window, select any of the configuration files listed in
the Connector folder and right-click on it.

2. Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing file as the template.

+ To create a new template, see [‘Creating a new template” on page 63|

* To use an existing file, simply modify an existing template and save it under the
new name.
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Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template:

1.
2.

Click File>New>Connector-Specific Property Template.

The Connector-Specific Property Template dialog box appears, with the
following fields:

Template, and Name

Enter a unique name that identifies the connector, or type of connector, for
which this template will be used. You will see this name again when you
open the dialog box for creating a new configuration file from a template.

Old Template, and Select the Existing Template to Modify

The names of all currently available templates are displayed in the Template
Name display.

To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template will appear in the Template Preview
display. You can use an existing template whose property definitions are
similar to those required by your connector as a starting point for your
template.

Select a template from the Template Name display, enter that template name in
the Find Name field (or highlight your selection in Template Name), and click
Next.

If you do not see any template that displays the connector-specific properties used
by your connector, you will need to create one.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

After you have made selections for the general characteristics of the property, click

the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1.

Click the Value tab. The display panel for Value replaces the display panel for
General.
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n

Select the name of the property in the Edit properties display.

In the fields for Max Length and Max Multiple Values, make any changes. The
changes will not be accepted unless you also open the Property Value dialog
box for the property, described in the next step.

Right-click the box in the top left-hand corner of the value table and click Add.
A Property Value dialog box appears. Depending on the property type, the
dialog box allows you to enter either a value, or both a value and range. Enter
the appropriate value or range, and click OK.

The Value panel refreshes to display any changes you made in Max Length
and Max Multiple Values. It displays a table with three columns:

The Value column shows the value that you entered in the Property Value
dialog box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value
dialog box.

After a value has been created and appears in the grid, it can be edited from
within the table display. To make a change in an existing value in the table,
select an entire row by clicking on the row number. Then right-click in the
Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventElimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1.

In the Available Properties display, select the property that will be made
dependent.

In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

In the Condition Operator field, select one of the following:
== (equal to)

!= (not equal to)

> (greater than)

< (less than)

>= (greater than or equal to)

<=(less than or equal to)

In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the\bin directory where you
have installed Connector Configurator Express.
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Creating a new configuration file

You create a connector configuration file from a connector-specific template or by
modifying an existing configuration file.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Click File>New>Connector Configuration.
2. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of
the name that you enter. You must ensure that the name is
correct.

* System Connectivity
The default broker is ICS. You cannot change this value.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

3. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector names. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

4. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator Express indicates that the configuration file was successfully
created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

5. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator Express window, as described later in this
chapter.
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Using an existing file

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then save the file as
a configuration file (*.cfg).

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An InterChange Server Express repository file.
Definitions used in a previous InterChange Server Express implementation of
the connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *x.cfg or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (x.cfg)
* InterChange Server Express Repository (*.1in, *.out)

Choose this option if a repository file was used to configure the connector. A
repository file may include multiple connector definitions, all of which will
appear when you open the file.

o All files (*.*)

Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.
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Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

Connector Configurator Express requires values for properties described in the
following sections:

* [“Setting standard connector properties”|

+ [“Setting application-specific configuration properties” on page 68

* [“Specifying supported business object definitions” on page 69

* [“Associated maps” on page 70

« |“Setting trace/log file values” on page 71|

Note: For connectors that use JMS messaging, an additional category may display,
for special configuration of data handlers that convert the data to business
objects. For further information, see [“Data handlers” on page 72

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* You can configure Value fields.

e The Update Method displayed for each property indicates whether a component
or agent restart is necessary to activate changed values.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.
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3. After entering all the values for the standard properties, you can do one of the
following;:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

Setting application-specific configuration properties
For application-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.
3. To encrypt a property, select the Encrypt box.

4. Choose to save or discard changes, as described for [“Setting standard connector]
[properties” on page 67|

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Edit Property window. To decrypt a value, click to clear the Encrypt
check box, enter the correct value in the Verification dialog box, and click OK. If
the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method

Refer to the descriptions of update methods found in the Standard configuration
properties for connectors appendix, under [’Setting and updating property values” on|
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Connector properties are almost all static and the Update Method is Component
restart. For changes to take effect, you must restart the connector after saving the
revised connector configuration file.

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

For you to specify a supported business object, the business objects and their maps
must exist in the system. Business object definitions, including those for data
handler meta-objects, and map definitions should be saved into Integration
Component Library (ICL) projects. For more information on ICL projects, see the
User Guide for WebSphere Business Integration Server Express.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications. For more information, see the
chapter on business objects in this guide as well as the Business Object
Development Guide.

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name

To designate that a business object definition is supported by the connector, with
System Manager running:

1. Click an empty field in the Business Object Name list. A drop-down list
displays, showing all the business object definitions that exist in the System
Manager project.

2. Click on a business object to add it.

w

Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to the project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support

If a business object has Agent Support, the system will attempt to use that business
object for delivering data to an application via the connector agent.
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Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level

The maximum transaction level for a connector is the highest transaction level that
the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:

* Business Object Name
These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps

The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.
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If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.

If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.

To explicitly bind a map:

1.

In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.
3. In the File menu of the Connector Configurator Express window, click Save
to Project.
4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.
Resources

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,
since it is usually more efficient to use multiple threads than multiple processes.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):

Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

To File:

Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. (If your connector is not running on the
Windows platform on which you have installed Connector Configurator
Express, you must first map a drive to a location on the system where you
want the file. ) Logging or tracing message are written to the file and
location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .10og and .txt are typical file extensions.
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Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Adapters that make use of the guaranteed event
delivery enable this tab.

See the descriptions under ContainerManagedEvents in the Standard Properties
appendix for values to use for these properties.

Saving your configuration file

After you have created the configuration file and set its properties, you need to
deploy it to the correct location for your connector. Save the configuration in an
ICL project, and use System Manager to load the file into InterChange Server
Express.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

¢ In stand-alone mode, as a file with a *.cfg extension in a directory folder.

For details about using projects in System Manager, and for further information
about deployment, see the User Guide for IBM WebSphere Business Integration Server
Express.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTF-8 encoding.

Connector Configurator Express supports non-English characters in:

* All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.
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For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"
isRequired="true"

updateMethod="component restart">
<ValidType>String</ValidType>

<ValidValues>

<DefaultValue>en US</DefaultValue>

</ValidValues>
</Property>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>
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Notices

Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing IBM Corporation North Castle Drive Armonk, NY
10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Burlingame Laboratory Director IBM Burlingame Laboratory 577 Airport
Blvd., Suite 800 Burlingame, CA 94010 U.S.A
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Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE

This information may contain sample application programs in source language,
which illustrates programming techniques on various operating platforms. You
may copy, modify, and distribute these sample programs in any form without
payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.

However, this information may also contain diagnosis, modification, and tuning

information. Diagnosis, modification and tuning information is provided to help
you debug your application software.
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Note: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International

Business Machines Corporation in the United States or other countries, or both:

IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino

Lotus

Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the

United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other

countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of

others.

Notices

77



78  Adapter for JD Edwards OneWorld User Guide






Printed in USA



	Contents
	About this document
	Audience
	Prerequisites for this document
	Related documents
	Typographic conventions

	New in this release
	New in Release 4.3.1
	New in Release 4.3

	Chapter 1. Overview
	Terminology
	Adapter overview
	Connector architecture
	Business functions
	Request processing
	Processing application events

	How the connector works
	Processing locale-dependent data

	Chapter 2. Installing the adapter
	Compatibility
	Assumptions and third-party dependencies
	Platform requirements

	Installing the adapter for JD Edwards OneWorld and related files
	WebSphere Business Integration Server Express Plus Adapter directories and files
	Adapter file structure
	Post-installation tasks
	Configure the adapter
	Copy files
	Create an ODBC connection


	Chapter 3. Configuring the connector
	Configuring the connector
	Standard connector properties
	Connector-specific properties

	Creating multiple connector instances
	Creating a new directory

	Starting the connector
	Invoking the start-up script on Windows
	Invoking the start-up script on OS/400

	Stopping the connector
	Stopping the connector from Windows
	Stopping the connector from OS/400

	Installing and configuring IBM event store
	Using log and trace files

	Chapter 4. Creating and modifying business objects
	Overview of the ODA for OneWorld
	Generating business object definitions
	Starting the ODA
	Running Business Object Designer Express
	Stopping the ODA

	Uploading business object files

	Chapter 5. Understanding business objects
	Defining metadata
	Connector business object structure
	Attributes
	Business functions
	Custom business functions
	Application-specific information

	Sample business object properties
	Sample GenJava script file
	Business object structure for the above example
	AddressBook
	D0100033

	Generating business objects

	Chapter 6. Error handling
	Error handling
	Adapter
	ODA

	Logging
	Tracing
	Enabling the connector to work with a DB2 database


	Appendix A. Standard configuration properties for connectors
	Configuring standard connector properties
	Using Connector Configurator Express
	Setting and updating property values

	Summary of standard properties
	Standard configuration properties
	AdminInQueue
	AdminOutQueue
	AgentConnections
	AgentTraceLevel
	ApplicationName
	BrokerType
	CharacterEncoding
	ConcurrentEventTriggeredFlows
	ContainerManagedEvents
	ControllerStoreAndForwardMode
	ControllerTraceLevel
	DeliveryQueue
	DeliveryTransport
	DuplicateEventElimination
	EnableOidForFlowMonitoring
	FaultQueue
	JvmMaxHeapSize
	JvmMaxNativeStackSize
	JvmMinHeapSize
	jms.FactoryClassName
	jms.MessageBrokerName
	jms.NumConcurrentRequests
	jms.Password
	jms.UserName
	Locale
	LogAtInterchangeEnd
	MaxEventCapacity
	MessageFileName
	MonitorQueue
	OADAutoRestartAgent
	OADMaxNumRetry
	OADRetryTimeInterval
	PollEndTime
	PollFrequency
	PollQuantity
	PollStartTime
	RequestQueue
	RepositoryDirectory
	ResponseQueue
	RestartRetryCount
	RestartRetryInterval
	SourceQueue
	SynchronousRequestQueue
	SynchronousResponseQueue
	SynchronousRequestTimeout
	WireFormat


	Appendix B. Connector Configurator Express
	Overview of Connector Configurator Express
	Starting Connector Configurator Express
	Running Configurator Express in stand-alone mode

	Running Configurator Express from System Manager
	Creating a connector-specific property template
	Creating a new template

	Creating a new configuration file
	Creating a configuration file from a connector-specific template

	Using an existing file
	Completing a configuration file
	Setting the configuration file properties
	Setting standard connector properties
	Setting application-specific configuration properties
	Specifying supported business object definitions
	Business object name
	Agent support
	Maximum transaction level
	Associated maps
	Resources
	Setting trace/log file values
	Data handlers

	Saving your configuration file
	Completing the configuration
	Using Connector Configurator Express in a globalized environment

	Notices
	Notices


